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£/ About Cetus CNotePad

Cetus CNotePad Text Editor is an enhanced replacement for the Windows 95 Notepad
application that is provided with the Windows 95 operating system. CNotePad provides the
basic functionality of Notepad, but also features a multiple document interface, a spell
checking function, and a more complete Help file.

Note: CNotePad is a 32-bit application, for use specifically with Windows 95. For those users
who are not (yet) using a 32-bit Windows operating system, Cetus Software also distributes
NotePad3, essentially the same program but for 16-bit Windows 3.x.

If you have questions about CNotePad, if you have any suggestions for improvements for
CNotePad, or if you would like information about our other freeware and shareware software
products, please contact us at:

Cetus Software Inc.

Post Office Box 700

Carver, MA 02330 USA
Email: users@cetussoft.com

Please feel free to visit our Web site at http://www.cetussoft.com, where you may download
free copies of the latest versions of all of our programs.

Cetus Software hopes you will be pleased with CNotePad.
Go to Cetus Freeware

Go to Cetus Shareware
Back to Contents




R“ﬁ Cetus Freeware Products

Softuare

The following freeware programs are being distributed by Cetus Software:

Cetus CNotePad Text Editor is an enhanced replacement for the Windows 95 Notepad
application that is provided with the Windows 95 operating system. CNotePad provides
the basic functionality of Notepad, but also features a multiple document interface, a spell
checking function, and a more complete Help file. (CNotePad is a 32-bit application, for
use with Windows 95. Cetus Software also distributes NotePad3, essentially the same
program but for 16-bit Windows 3.x.)

Cetus CWordPad Word Processor is an enhanced implementation of the Windows 95
WordPad application that is provided as an accessory with the Windows 95 operating
system. CWordPad provides all the functionality of WordPad, plus it also features a spell
checking function and a more complete Help file.

Cetus FloppyWord Word Processor is a floppy-only implementation of the Windows 95
WordPad application that is provided as an accessory with the Windows 95 operating
system. FloppyWord provides all of the functionality of WordPad, as well as a spell
checking function and a more complete Help file, but is restricted to use with document
files on either the A: or B: drive.

FloppyWord will not open files from a hard drive, nor will it save files to a hard drive.
FloppyWord is intended to be used as a restrictive replacement for a "normal” word
processor (such as WordPad), whenever it is desired to restrict guest users of a Windows
95 PC from opening files from, or saving files to, a hard drive.

FloppyWord is being provided for any Windows 95 user who, for security reasons, has a
need for its restrictive functionality. We at Cetus Software (creator of Windows security
software products) have found that system administrators at many institutions,
particularly schools, have expressed a need for a product such as FloppyWord, to allow
the use of a word processor that does not read from or write to a PC's hard drive.
Because of this, FloppyWord is being provided as freeware by Cetus Software.

Cetus NotePad3 Text Editor is an enhanced replacement for the Windows Notepad
application that is provided with the Windows 3.x and Windows for Workgroups 3.x
operating systems. NotePad3 provides all the basic functionality of Notepad, but it also
features a multiple document interface, a spell checking function, and a more complete
Help file. (NotePad3 is a 16-bit application, for use with Windows 3.x. For those users who
are running Windows 95, Cetus Software also distributes CNotePad, essentially the same
program in appearance and function, but designed as a 32-bit application.)

Cetus Software hopes you will try, and will be pleased with, our products.

Contacting Cetus Software

Jump to Cetus Shareware

Back to Contents




v Contacting Cetus Software

Softuare

If you have questions about CNotePad, if you have any suggestions for improvements for
CNotePad, or if you would like information about our other freeware and shareware software
products, please contact us at:

Cetus Software Inc.

Post Office Box 700

Carver, MA 02330 USA
Email: users@cetussoft.com

Please feel free to visit our Web site at http://www.cetussoft.com, where you may download
free copies of the latest versions of all of our programs.

Cetus Software hopes you will be try, and be pleased with, our products.

Jump to Cetus Freeware

Jump to Cetus Shareware
Back to Contents




R“ﬁ Cetus Shareware Products

Softuare

The following shareware programs are being distributed by Cetus Software:

e StormWindows for Windows 95 will allow the authorized user to add several types and
degrees of protections to the desktop and system of a Windows 95 computer. Intelligent
use of StormWindows security measures will allow secure use of any shared Windows 95
computer.

e StormWindows desktop protections include: hiding all desktop icons; preventing the
saving of desktop changes; hiding all drives in "My Computer"; hiding the Start Menu
Subfolders, Settings, and/or Taskbar; and hiding the entire "Network Neighborhood", or
just "Entire Network™ or "Workgroup Contents" in it.

e StormWindows system protections include: disabling the MS-DOS prompt and/or the
running of MS-DOS applications; blocking the running of Registration Editor and/or
System Policy Editor; preventing the merging of .REG files into the Registry; preventing
the addition or deletion of printers; and individually hiding "sensitive" Control Panel
pages and settings.

¢ StormWindows protections would probably be most useful to someone in charge of a
number of computers at a school or business, a network manager, or a parent. Access to
the program is password protected.

e ProGuard V.2.2 password-protects Windows 3.1x icons, making it impossible for guest
users to run selected programs simply by double-clicking on their icons in Program
Manager. ProGuard can also prevent guest users from creating, modifying, copying,
moving, or deleting Program Manager icons, or from using the New, Move, Copy, Delete,
and Run commands in Program Manager's File Menu.

e WinGuard V.2.4 is a Windows 3.1x program that offers considerable global security for the
Program Manager desktop. Perhaps the best description of WinGuard was provided by
John Hedtke in a review in "Mobile Office” Magazine:

e "Other than using the Windows screen saver to restrict access to Windows completely,
the big security issues for Windows users are freezing your desktop configuration and
restricting access to specific program groups. WinGuard from Cetus Software can take
care of both problems."

e "l like WinGuard's screen layout. The toolbar at the top of the screen is convenient for
quick access to system features. When you move the pointer over the buttons, you get
help at the bottom of the screen. The help file is quite professional and complete.”

e "WinGuard provides seven levels of protection. At the lowest, no rearrangement of the
Program Manager will be saved. At increasingly higher levels, users can't change
program groups, program items, command lines, or item properties. At the highest two
security levels, users can't start a program with the Run line, and the File menu is
removed entirely from Program Manager."

e "You can't hide specific icons (except for parts of the Control Panel), but you can hide
program groups. You can use this feature along with the protection levels to lock
Windows up pretty tightly. For example, you can use WinGuard to lock out the File Run
menu and then lock out access to the DOS and File Manager icons by hiding the Main
program group. Guest users won't be able to run any program they can't see an icon for.

e "You need to restart Windows to enable the changes you've made. Making subsequent
changes isn't difficult: run WinGuard again, give it your password, and blaze away. (The
default password is "shield" but you should change this to something else.)"

Cetus Software hopes you will try, and will be pleased with, our products.
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Menu and Button Commands

File Functions
Edit Functions
Spelling Functions
View Functions
Window Functions

Help Functions
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File Functions

New

Open...
Close

Save

Save As...
Print...

Print Preview
Page Setup...

Print Setup...
Recently Used Files

Make Default .TXT Editor
Exit

Back to Commands List
Back to Contents




0| File New

Creates a new document.

Since CNotePad is a Multiple Display Interface (MIDI) application, selecting File New will place
the new document window above any other document window currently in view, and will not
replace it.

To quickly create a new document, click the New button on the toolbar.
(To open an existing document, use the File Open command.)

See also:

File Open...



2| File Open...

Opens an existing document.
(Exactly like Notepad, CNotePad cannot open a file much larger than approximately 60 KB.)
To quickly open an existing document, click the Open button on the toolbar.

CNotePad keeps track of the documents you last worked on. You can quickly open one of
them by selecting it from the File menu.

(To create a new document, use the File New command.)
See also:
File Recently Used Files

File New
Making CNotePad the Default Text Editor




File Recently Used Files

CNotePad keeps track of the documents you last worked on. You can quickly open one of
them by selecting it from the File menu.

See also:

File Open...



CNotePad as Default Text Editor

You might find that you like CNotePad enough that you would like to make it your default text
editor (and that is Cetus Software's hope). To do so you need to associate CNotePad with the
".txt" file extension. Doing this will cause double-clicking on any ".txt" file in Explorer to
launch CNotePad with the file already loaded.

If you wish to make CNotePad your default text editor for ".txt" files, use the File Make Default
.TXT Editor function. Ordinarily, this will cause CNotePad to be associated with the ".txt" file
extension automatically. (If this function does not succeed, you will have to associate the
"txt" extension manually, using "standard" Windows functions.)

Back to Contents




File Close

Closes the current document. CNotePad prompts you to save any unsaved changes in the
current document.

Since CNotePad is a Multiple Display Interface (MIDI) application, selecting File Close will not
cause CNotePad itself to close, but only cause the current open document to close.

See also:

File Exit



File Exit

Ends a CNotePad session. CNotePad prompts you to save any unsaved changes in any open
documents.

You can also exit CNotePad by doing one of the following:

e  Open the Control menu and choose Close.

¢ Double-click the Control menu box.

¢ Single-click the "X" button at the right end of the title bar.
See also:

File Close



H| File Save

Saves the active document with the name, location, and file format you previously set in the
Save As dialog box.

When you save a document for the first time, CNotePad displays the Save As dialog box.
When you choose Save, the document remains open so you can continue working on it.

If you want to change the name, location, or file format of an existing document, choose the
Save As command.

To quickly save a document with its existing name, location, and file format, click the Save
button on the toolbar.

See also:

File Save As...



File Save As...

Displays the Save As dialog box, where you specify the name, location, and file format of the
active document.

When you choose Save As, the document remains open so you can continue working on it.

To quickly save a document with its existing name, location, and file format, click the Save
button on the toolbar.

See also:

File Save



&| File Print...

Controls how a document is printed. Before using this command, you must install and select
a printer. To install a printer, see your Windows documentation. To select a printer, use the
Print Setup dialog box.

To quickly print the current document, click the Print button on the toolbar.
See also:
File Print Setup...

File Page Setup...
File Print Preview




File Print Setup...

Allows selecting the printer to use and the size and orientation of the paper to be used while
printing.

See also:
File Print...

File Print Preview
File Page Setup...




File Print Preview

Shows how a document will look when you print it. You can use the Print Preview toolbar to
make changes before you print.

See also:

File Print...
File Print Setup...
File Page Setup...




File Page Setup...

Changes the header and footer format for printing a document.

See also:

File Print...
File Print Setup...
File Print Preview




File Make Default . TXT Editor

Causes CNotePad to be associated with the ".txt" file extension.

See also:

CNotePad as Default Text Editor




Select All

Word Wrap
Back to Commands List

Back to Contents




Edit Undo

If possible, reverses the last change made in a document.



[#| Edit Cut

Removes selected text and puts it on the Clipboard. This command is available only when
you select text.

Text that you place on the Clipboard remains there until you replace it with a new item.

To quickly remove selected information from the document and place it on the Clipboard,
click the Cut button on the toolbar.

See also:
Edit Delete

Edit Copy
Edit Paste



Edit Delete

Deletes selected text from a document, but does not place the text onto the Clipboard.

Use Delete when you want to delete text from the current CNotePad document but you have
text on the Clipboard that you want to keep.

See also:

Edit Cut



Edit Copy

Copies selected text to the Clipboard. This command is available only when you select text.
Text that you copy to the Clipboard replaces the previous contents.

To quickly copy information to the Clipboard, click the Copy button on the toolbar.

See also:

Edit Cut
Edit Paste



B| Edit Paste

Inserts a copy of the Clipboard contents at the insertion point, replacing the selection (if any)
with the text on the Clipboard. This command is not available if the Clipboard is empty.

To quickly insert the Clipboard contents at the insertion point, click the Paste button on the
toolbar.

See also:

Edit Cut
Edit Copy



Edit Find...

Searches for specified text in the document.

You can match uppercase and lowercase letters, or perform a case-insensitive search for text.
You can search forward or backward from the insertion point.

See also:

Edit Find Next
Edit Replace...



Edit Find Next

Repeats the last search without opening the Find dialog box.
See also:

Edit Find...
Edit Replace...



Edit Replace...

Searches for and replaces specified text.

You can match uppercase and lowercase letters, or perform a case-insensitive search for text
to replace.

See also:

Edit Find...
Edit Find Next



Edit Select All

Selects the text of the entire CNotePad document.

You can copy the selected text onto the Clipboard, delete it, or perform other editing actions.

See also:

Edit Cut

Edit Copy
Edit Paste

Edit Delete



Edit Word Wrap

Wraps text in the current document at the end of each line.



Spelling Functions

Check Document
Check Selection
Options...
Dictionaries...

Back to Commands List
Back to Contents




%] Spelling Check Document

The Check Spelling Dialog appears if a word requiring your attention is detected anywhere
within the document. You can use the dialog to specify whether the word should be ignored
or replaced.

Add button: Causes the reported word to be added to the dictionary selected in the Add
Words To list.

Add Words To list: Indicates which user dictionary words will be added to when you select
the Add button.

Change button: Causes the reported word to be replaced with the word in the Change To box.

Change All button: Causes this and all following occurrences of the reported word to be
replaced with the word in the Change To box.

Change To box: Contains a word which will replace a misspelled word when you select the
Change or Change All buttons.

Consider Changing box: Contains a word which may be misspelled or otherwise incorrect,
and is presented with a candidate replacement word.

Ignore button: Causes this occurrence of a misspelled word to be skipped.

Ignore All button: Causes this and all further occurrences of a misspelled word to be skipped.
Lock checkbox: Locks the position of the Check Spelling dialog in place.

Not in dictionary box: Indicates that a misspelled word was detected.

Suggest button: Causes a set of suggested replacements for misspelled words to be added to
the Suggestions list.

Back to Spelling Functions
Back to Contents




¥| Spelling Check Selection

The Check Spelling Dialog appears if a word requiring your attention is detected within
selected text. You can use the dialog to specify whether the word should be ignored or
replaced.

Add button: Causes the reported word to be added to the dictionary selected in the Add
Words To list.

Add Words To list: Indicates which user dictionary words will be added to when you select
the Add button.

Change button: Causes the reported word to be replaced with the word in the Change To box.

Change All button: Causes this and all following occurrences of the reported word to be
replaced with the word in the Change To box.

Change To box: Contains a word which will replace a misspelled word when you select the
Change or Change All buttons.

Consider Changing box: Contains a word which may be misspelled or otherwise incorrect,
and is presented with a candidate replacement word.

Ignore button: Causes this occurrence of a misspelled word to be skipped.

Ignore All button: Causes this and all further occurrences of a misspelled word to be skipped.
Lock checkbox: Locks the position of the Check Spelling dialog in place.

Not in dictionary box: Indicates that a misspelled word was detected.

Suggest button: Causes a set of suggested replacements for misspelled words to be added to
the Suggestions list.

Back to Spelling Functions
Back to Contents




Spelling Options...

You can use the Options Dialog to specify various SpellChecker options.

Ignore Capitalized Words: When enabled, any words beginning with a capital letter are
ignored.

Ignore All-Caps Words: When enabled, any words containing all capital letters are ignored.

Ignore Words with Numbers: When enabled, any words containing embedded digits are
ignored.

Ignore Words with Mixed Case: When enabled, any words containing an unusual mixture of
upper- and lower-case letters are ignored.

Report Doubled Words: When enabled, any word appearing twice in a row is reported via the
Check Spelling Dialog.

Case Sensitive: When enabled, a distinction is made between capitalized and non-capitalized
words..

Always Suggest: When enabled, a list of suggested replacements is automatically displayed
when a misspelled word is reported.

Phonetic Suggestions: When enabled, suggestions are made on the basis of phonetic
similarity as well as typographical similarity..

Suggest Split Words: When enabled, two separate words will be suggested as a replacement
for a misspelling containing two joined words.

OK button: Closes the Options Dialog, and saves any changes made to the option settings.

Cancel button: Closes the Options Dialog, and discards any changes made to the option
settings.

Back to Spelling Functions
Back to Contents




Spelling Dictionaries...

The Dictionaries Dialog allows you to open and close user dictionaries, and to edit the
contents of an open user dictionary.

Add File button: Opens a user dictionary file. When you select the Add File button, a dialog
appears which you can use to select the dictionary file to open.

Add Word button: Causes the word entered in the edit area of the Words list to be added to
the currently selected dictionary.

Close button: Closes the Dictionaries dialog.

Delete Word button: Causes the word appearing in the edit area of the Words list to be
removed from the currently selected dictionary.

Export button: Saves the contents of the currently selected dictionary to a text file.

Files list: Contains the list of open dictionary files.

Import button: Adds the words contained within a text file to the currently selected dictionary.
Language: Displays the language of the words in the currently selected dictionary.

New button: Creates a new user dictionary file.

Remove File button: Closes the currently selected dictionary file.

Type: Displays the type or purpose of the currently selected user dictionary.

Words list: Contains the list of words in the currently selected user dictionary.

Back to Spelling Functions
Back to Contents




View Functions

Toolbar

Status Bar

Set Tab Stops...

Set Font...

Set Printer Font...
Mirror Display Font
Back to Commands List
Back to Contents




View Toolbar

Displays (or hides) the main CNotePad toolbar, which has buttons to help you quickly access
frequently used commands.

A brief description of each button may be obtained by holding the mouse over the button and
observing the text at the left end of the status bar.

A very brief description of each button may be obtained by holding the mouse over the button
and observing the "Tooltip" that appears nearby.



View Status Bar

Displays (or hides) the CNotePad status bar, located at the bottom of the CNotePad window,
which shows a brief explanatory message about any button over which the mouse is held or
about any menu command over which the mouse is dragged.



View Set Tab Stops...

Allows you to set the number of spaces used for each tab stop.



View Set Font...

Allows you to select the font, font style, and font size used for viewing a document.
See also:

View Set Printer Font...
View Mirror Display Font




View Set Printer Font...

Allows you to select the font, font style, and font size used for printing a document.
See also:

View Set Font...
View Mirror Display Font




View Mirror Display Font

Select this command if you want the font used for printing to match the font used for viewing
a document.

See also:

View Set Font...
View Set Printer Font...




Window Functions

Cascade

Tile Vertically

Tile Horizontally
Arrange Icons
Windows

Back to Commands List
Back to Contents




Window Cascade

Causes open documents to be arranged in overlapping windows.
See also:

Window Tile Horizontally
Window Tile Vertically
Window Arrange Icons
Window Windows




Window Tile Horizontally

Causes open documents to be arranged as non-overlapping tiles, from top to bottom, one
above the other.

See also:

Window Tile Vertically
Window Cascade
Window Arrange Icons
Window Windows




Window Tile Vertically

Causes open documents to be arranged as non-overlapping tiles, from left to right, one next
to the other.

See also:

Window Tile Horizontally
Window Cascade
Window Arrange Icons
Window Windows




Window Arrange Icons

Lines up icons for any minimized open documents.
See also:

Window Cascade
Window Tile Horizontally
Window Tile Vertically
Window Windows




Window Windows

(Yes, we know it sounds like a silly title for this function.)
List currently open document windows at the bottom of the Window menu.

If a large number of document windows are open, clicking on More Windows will display a list
box of all open windows.

See also:

Window Cascade
Window Tile Horizontally
Window Tile Vertically
Window Arrange Icons




Help Functions

Help Topics

About CNotePad

Cetus Freeware

Cetus Shareware

Back to Commands List
Back to Contents




2| Help Topics

Opens this Help file to this Contents page.

See also:

Help Functions




Help About CNotePad

Displays program information, version number, and copyright.

Jump to About CNotePad




Help Cetus Freeware

Provides information on freeware software products distributed by Cetus Software.

Jump to Cetus Freeware




Help Cetus Shareware

Provides information on shareware software products distributed by Cetus Software.

Jump to Cetus Shareware




HowDol...

Obtain Help ?

Find Text ?

Format Text ?

Delete Text ?

Make CNotePad My Default Text Editor ?
Contact Cetus Software ?

Go Back to Help Contents ?




Obtaining Help

You may move from one topic to another in this Help file by clicking with the mouse on any
underlined "jump" item. From the keyboard, you may use the Tab key to highlight any item,
and then press Enter.

A brief description of any CNotePad menu command may be obtained by dragging the mouse
over the menu item.

A brief description of any CNotePad toolbar button may be obtained by holding the mouse
over the button and observing the text at the left end of the status bar.

See also:

Help Functions




Finding Text

You can start a search for specific text at any point in a CNotePad document.
To find specific characters or words

Move the insertion point to where you want the search to begin.

From the Edit menu, choose Find.

Type the characters or words you want to find.

If you want to match capitalization exactly, select the Match Case check box.
To specify the search direction, select the Up or Down option.

Choose the Find Next button.

To find the next occurrence of the text, choose the Find Next button again.

You may also close the Find dialog box and choose Find Next from the Search menu or press
F3.

NOoOO b ON -

You may replace selected text with text currently on the Clipboard using the Edit Replace
command.

See also:

Edit Find...
Edit Find Next

Edit Replace...
Back to Contents




Formatting Text

To format text, do the following:

e Toendaline, press ENTER.
e Toindent a line, press TAB.
e Toinsert a tab, press TAB.

e To insert a blank line, move the insertion point to the beginning or end of a line, and then
press ENTER.

You may also change Tab and Font settings using these View commands:

View Set Tab Stops
View Set Font

View Set Printer Font
View Mirror Display Font
Back to Contents




Deleting Text

Use the BACKSPACE or DEL key, or the Delete command, when you want to delete text from
the current Notepad document but you have text on the Clipboard that you want to keep.

Use the Cut command when you wish to move text from the active document to the
Clipboard, replacing the contents of the Clipboard in the process.

To delete one character at a time

e Press BACKSPACE to delete the character to the left of the insertion point.
¢ Press DEL to delete the character to the right of the insertion point.
To delete more than one character

1 Select the text you want to delete.

2 Press BACKSPACE or DEL.

e Or choose Delete from the Edit menu.

To place the text onto the Clipboard, choose Cut from the Edit menu.

See also:
Edit Cut

Edit Delete
Back to Contents




ETU
U Cetus Freeware and Shareware

Softuare

Cetus Software is the distributor of several freeware and shareware products. Look for them
on the various online services as well as on the Internet (including at our Web site,
http://www.cetussoft.com).

(For those without easy access to these sources, Cetus Software will provide copies on
diskette of any for the nominal fee of $5.00 each, postpaid.)

For further information on any Cetus Software product, please contact:

Cetus Software Inc.

Post Office Box 700

Carver, MA 02330 USA
Email users@cetussoft.com

Please feel free to visit our Web site at http://www.cetussoft.com, where you may download
free copies of the latest versions of all of our programs.

Cetus Freeware Products
Cetus Shareware Products
Back to Contents




%] Spelling Check Document

Checks the spelling in the entire document.

The Check Spelling Dialog appears if a word requiring your attention is detected anywhere
within the document. You can use the dialog to specify whether the word should be ignored
or replaced.

See also:

Spelling Check Selection




¥| Spelling Check Selection

Checks the spelling only in words that have been selected (highlighted).

The Check Spelling Dialog appears if a word requiring your attention is detected within the
selected text. You can use the dialog to specify whether the word should be ignored or
replaced.

See also:

Spelling Check Document










